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Acronym

CAD ................................computer-aided design

LAP .................................learning activity performance

OHS.................................Occupational health and safety

MS ..................................Microsoft
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In structural construction work; the Operate Application software  of structural construction 

work helps to know use a range of prepare relevant information for software application 

procedures, perform CAD and Microsoft office project package is booted properly, 

Necessary tools and equipment are identified..

This module is designed to meet the industry requirement under the structural construction 

work occupational standard, particularly for the unit of competency Read and interpret 

building drawing and specifications. 

This module covers the units:

 CAD and micro soft office project environment Measurement, 

 Open software application and manipulate desktop 

 Print  

 Shut down computer 

Learning Objective of the Module

 Prepare the CAD and micro soft office project environment.

 System of open software application and manipulate desktop environment

 Preform Print information

 Perform Shut down computer 

Module Instruction

For effective use this modules trainees are expected to follow the following module 

instruction:

1. Read the information written in each unit

2. Accomplish the Self-checks at the end of each unit

3. Perform Operation Sheets which were provided at the end of units 

4. Do the “LAP test” giver at the end of each unit and

5. Read the identified reference book for Examples and exercise

                                             Introduction to the Module
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Unit one:  CAD and micro soft office project environment Measurement,

This unit is developed to provide you the necessary information regarding the following content 

coverage and topics:

 work health and safety 

 Software application procedures. 

 Tools and equipment 

 CAD and Microsoft office Project package.

 Screen display 

This unit will also assist you to attain the learning outcomes stated below. Upon completion of 

this learning guide, you will be able to:

 Apply work health and safety 

 Prepare software application procedures. 

 Identify tools and equipment. 

 Perform CAD and Microsoft office Project package.

 Display screen with instruction 
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1.1.  work health and safety 

1.1.1. Definition

Occupational health and safety is the discipline concerned with preserving and protecting 

human resources in the workplace. Occupational health is the adaptation of work to man and 

of each man to his job. It has the following components.

 Promotion and maintenance of the highest degree of physical, mental and social 

wellbeing of workers in all occupations;

  Prevention among workers of departures from health caused by their working 

conditions

 Protection of workers in their employment from risks resulting from factors adverse to 

health; and

  Placing and maintenance of a worker in an occupational environment adapted to his 

physiological and psychological equipment.

What is Occupational Health?

Occupational health deals with all aspects of health and safety in the workplace and

has a strong focus on primary prevention of hazards. The health of the workers have several 

determinants, including risk factors at the workplace leading to cancers, accidents, 

musculoskeletal diseases, respiratory diseases, hearing loss, circulatory diseases, stress 

related disorders and communicable diseases and others.

1.1.2. Objectives of Occupational Health and Safety

The ten high priority objectives proposed by the strategy are as follows:

 Strengthening of international and national policies for health at work and 

developing the necessary policy tools

 Development of healthy work environment

 Development of healthy work practices and promotion of health at work

 Strengthening of OHS

 Establishing of support services for occupational health

 Development of occupational health standards based on scientific risk assessment
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 Development of human resources for occupational health

 Establishment of registration and data systems, development of information

            Services for experts, effective transmission of data and raising of public awareness

             through public information

Strengthening of research

1.1.3. Principles of Occupational Health and Safety

Occupational health and safety is a multi-disciplinary field, covering issues related to law,

medicine, technology, economics and industry specific concerns. The core occupational

health and safety principles are as follows:

All workers have rights. Workers, as well as employees and government, must ensure 

that these rights are protected and foster decent conditions of labour. As the 

International Labor Conference stated in 1984:

 Work should take place in a safe healthy environment;

 Conditions of work should be consistent with workers‟ well-being and 

human dignity;

 Work should offer real possibilities for personal achievement, self-

fulfillment and service society1.

Occupational health and safety policies must be established. Such policies must be

implemented at both the governmental and enterprise levels. They must be effectively 

communicated to all parties concerned.

There is a need for consultation with the social partners (that is, employers and 

workers) and other stakeholders. This should be done during the formulation, 

Implementation and review of such policies.

Prevention and protection must be the aim of occupational health and safety 

Programmes and policies. Efforts must be focused on primary prevention at the 
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Workplace level. Workplaces and working environment should be planned and 

designed to be safe and healthy

1.1.4. Organizing Your Workspace

A computer performs five major operations or functions irrespective of its size and make. 

These are

it accepts data or instructions as input,

 it stores data and instruction

it processes data as per the instructions,

it controls all operations inside a computer, and

it gives results in the form of output.

1.1.5. Precautions to be taken against viruses

  Install a memory-resident program in RAM that will detect and warn if a virus 

is present.

  Do not allow hardware engineers or sales persons to put a write enabled floppy 

into your computer unless they can guarantee that it is not infected.

  Backup copies of all programs and data files should be kept.

  Backup copies of programs should be held as read-only disks to prevent 

infection.

  At least 2 copies of the backup must be kept.

  Never boot your machine with a floppy from an unknown source.

  Always write-protect your disk when you use it in another machine

1.2. Software application procedures

   1.2.1. CAD procedures

        Introduction
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AutoCAD is a Computer-Aided Drafting (CAD) software application built by Autodesk. It 

helps to create both 2D (Two dimensional) and 3D( Three-Dimensional) models of solid as 

well as mesh surfaces which helps engineers, architects, drafters, and other designing 

professionals to design the models instead of using manual hand drafting tools like pencils, 

rulers, compasses, drafting boards, etc. These conventional methods are time-consuming as 

well as not accurate. AutoCAD released in 1982; since then, it is used widely because of its 

accuracy, robust features, and automated drafting tools. AutoCAD helps you design and 

create the models, transform that model into 3D model renderings, and create animated 

presentations. AutoCAD provides many built-in layouts for users. This built-in layout 

contains various types of templates that are used for architecture planning and constructing 

buildings. In this article, we are going to see the steps to install AutoCAD on the windows 

system so that we can use that to create designs.

Steps to Install AutoCAD on windows system are given as follows:

 Step 1: Access the Autodesk website

Use web browsers like Google Chrome, Mozilla Firefox, etc. Then Go to the AutoCAD 

official website by using this link: https://www.autodesk.com

 Step 2: Select Students and Educators from Drop down list of the Menu.

It will give you three options, i.e. free trials, students and educators, and worldwide sites. 

Here I am selecting the students and educators option.

 Step 3: Then, you will see Get set up for career success with the Autodesk tab. From 

that tab, click on Start now under Download free software option.

 Step 4: It will give a list of Autodesk products like 3DS Max, Maya, AutoCAD, etc. 

Under that, click on the AutoCAD option from the list.

 Step 5: If you have already registered, then click on Sign in, and you will be 

forwarded to your Autodesk Login information. Otherwise, click on Create Account 

and create a new account using your email ID.

 Step 6: Select version After signing in, you can select the version of AutoCAD you 

want to download and install and Operating System: 32 bit or 64 bit.

Note: To check whether your operating system is 32 bit or 64 bit go to Control Panel > 

System and Security > System. It will display whether you are running a 32 bits system or 64 

bits system. Then choose a language which is preferable for you. The Serial number and 

https://www.educba.com/what-is-autodesk/
https://www.autodesk.com/
https://www.educba.com/32-bit-vs-64-bit-operating-system/
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product key will be displayed. Copy this information as it is required for activation purposes 

after installing the software to authenticate the download.

Now click on download. You will see a prompt with a security warning from the download. 

In that prompt, click “Run” or “Ok” (which is applicable to continue the download process) 

as Autodesk products are relatively secure

 Step 7: License and Services Agreement After that, you will see the “License and 

Services Agreement” Prompt. Read it carefully, and then click on the “I Accept” 

option, then click the next button to install AutoCAD on your Windows System

 Step 8: After the installation of the manager, you will see an “Autodesk Download 

Manager” window. Specify the desired path where you want to save that file and click 

on OK.

Fig.1.1.auto desk

The Autodesk Download manager will be loading.

 Step 9: After that, you will see a window where you can configure the Autocad 

installation process. Here give the path where you want to save the files

 Step 10: In the next window, select the Custom Option. Make sure all the features 

under the drop-down are checked.

 Step 13: After finishing the installation, you have to provide a Product Key to further 

the use of AutoCAD.

https://www.educba.com/windows-operators/
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    1.2.2. Microsoft office Project

 Procedures 

 Step 1: File -> Options -> General tab -> Project view -> Default view.

Fig.1.2.ms project

 Step 2: File -> Options -> Display tab -> Show Indicators and Options Buttons For.

Check all options.
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Fig.1.3.project options

 Step 3: File -> Options -> Schedule tab -> Schedule -> Show Assignment 

Units.

Choose “percentage” from the dropdown box.

Fig.1.4.project options
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 Step 4: File -> Options -> Schedule tab -> Calculation -> Calculate Project 

after Each Edit.

Check the On button.

Fig.1.5.schedule

Step 5: File -> Options -> Save tab -> Save projects -> Save Files In this format.

Select Project (*.mpp).

Fig.1.6. project options
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Step 6: File -> Options -> Advanced tab -> Edit. 

Check all options.

Fig.1.7.advanced tool

 Step 7: File -> Options -> Advanced tab -> Display -> Show Status Bar -> 

Show Scroll Bar.

Both options, Status Bar and Scroll Bar should be checked

Fig.1.8.work space



Version -1Page 16 of 61 Ministry of Labor and 
Skills

Author/Copyright

Operating application soft ware 

august, 2022

 Step 8: Resources -> Level -> Leveling Options -> Leveling Calculations.

Set to manual.

Fig.1.9.grant chart
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Fig.1.10.leveling options

 Step 9: Resources -> Level -> Leveling Options -> Leveling calculations -> 

Look for Over allocations.

Select “Day By Day” from dropdown box.

Fig.1.11.resource leveling

1.3. Tools and equipment 
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  1.3.1. Equipment 

printers 

Printer: Printers are used to produce paper (commonly known as hardcopy) output. Based on 

the technology used, they can be classified as Impact or Non-impact printers.

monitor

Monitor: is often used synonymously with “computer screen” or “display.” Monitor is an 

output device that resembles the television screen It may use a Cathode Ray Tube (CRT) to 

display information. The monitor is associated with a keyboard for manual input of characters 

and displays the information as it is keyed in. It also displays the program or application 

output.

Like the television, monitors are also available in different sizes.

desktop

A computer system consists of mainly four basic units; namely input unit, storage unit, 

central processing unit and output unit. Central Processing unit further includes

Arithmetic logic unit and control unit, as shown in

A computer performs five major operations or functions irrespective of its size and make. 

These are

it accepts data or instructions as input,

 it stores data and instruction

it processes data as per the instructions,

it controls all operations inside a computer, and

it gives results in the form of output.

        1.3.2. Tool

 keyboard

Keyboard: The keyboard is very much like a standard typewriter keyboard with a few 

additional keys. The basic QWERTY layout of characters is maintained to make it easy to use 

the system. The additional keys are included to perform certain special functions. These are 

known as function keys that vary in number from keyboard to keyboard.
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Fig.1.12.key board

 Mouse

Mouse: A device that controls the movement of the cursor or pointer on a display screen. A 

mouse is a small object you can roll along a hard and flat surface. Its name is derived from its 

shape, which looks a bit like a mouse. As you move the mouse, the pointer on the display 

screen moves in the same direction.

Fig.1.13. Mouse
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1.4. CAD and Microsoft office Project package.

      1.4.1. CAD 

The contents of this chapter are designed to introduce features of the AutoCAD 2007 window 

and methods of operating AutoCAD 2007.

Opening AutoCAD 2007

AutoCAD 2007 is designed to work in a Windows operating system. In general, to open 

AutoCAD 2007, either double-click on the AutoCAD 2007 shortcut in the Windows desktop 

or right-click on the icon, followed by a left-click on Open in the menu which then appears

Fig.1.14.autocad 2007

When working in education or in industry, computers may be configured to allow other 

methods of opening AutoCAD, such as a list appearing on the computer in use when the 

computer is switched on, from which the operator can select the program they wish to use.

When AutoCAD 2007 is opened a window appears, depending upon whether a Classic 

AutoCAD, a 3D Modeling or an AutoCAD Default workspace has been used previously. In 

this example the Classic AutoCAD workspace is shown and includes the drop-down menu 

from which a choice of the AutoCAD workspace to be opened can be made This Classic 

AutoCAD workspace shows:
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Fig.1.15. Standard toolbar

Workspaces  toolbar usually within the workspace.

Styles toolbar docked to the right of the Standard toolbar.

Layers toolbar docked under the Standard toolbar.

Properties toolbar docked to the right of the Layers toolbar.
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Fig.1.16.work space

Highlights of AutoCAD

Before the invention of AutoCAD, all designing and modeling were done manually. This was 

a time-consuming task and resulted in a lot of costly errors. But, with the invention of 

AutoCAD, the process of modeling and designing got digitalized and simplified. A 

technology that has emerged as a solution to most of the designers, engineers, and architects. 

Some of the most powerful components of AutoCAD are-

 The designers and architects can create accurate models, sketches, and drawings with 

AutoCAD. This is next to impossible when done manually.

With the introduction to AutoCAD, the user can even model 3D objects with colors & 

materials that can be applied to various surfaces, making it simpler for the user to anticipate 

the outcome, which cannot be fulfilled in manual 3D sketches

https://www.educba.com/careers-in-3d/
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Some of the most powerful components of AutoCAD are-

 The designers and architects can create accurate models, sketches, and drawings with 

AutoCAD. This is next to impossible when done manually.

 With the introduction to AutoCAD, the user can even model 3D objects with colors & 

materials that can be applied to various surfaces, making it simpler for the user to 

anticipate the outcome, which cannot be fulfilled in manual 3D sketches.

 Creating drawings manually is a time-consuming task. When designers create 

drawings on a digital platform with computer software, they get the benefit of the 

application interface. Editing is also easy with AutoCAD as it has many editing 

commands.

 AutoCAD is an advanced program that has default commands incorporated in the 

application. With these commands, the users can edit and change their files without 

any limitations.

Characteristics of AutoCAD

In the Above Section, we have learned about Introduction to AutoCAD; there are some main 

characteristics that one need:

 AutoCAD is a global application. It is being used globally by product development 

teams, manufacturing facilities, medical professionals, in educational institutions, by 

professionals and engineers.

 3D modeling and visualization are two main important features of the program. 

AutoCAD allows the modelers to create powerful 3d models, wireframes, meshes & 

surfaces by using various 3D tools & commands.

 AutoCAD is a professional application that has flexibility in design changes and has 

an auto-specification check feature. The mistakes in the designs or the product can be 

avoided and can be re-edit as and when required.

 AutoCAD has the capability to create section planes. These section planes help in 

achieving cross-sectional views of 3D objects. The users can change, select, or move 

the section planes to inspect the inner details of 3D objects.

 AutoCAD helps the user to develop, modify, and design better infrastructure, deliver 

scalable and feasible building assignments, supervise production finances, and foresee 

project results.

https://www.educba.com/careers-in-3d/
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 Recreating and editing 2D images with their text properties can also be achieved with 

AutoCAD.

 AutoCAD drawings can also be linked directly to Microsoft Excel Spreadsheets. With 

this technique, formulas and data from Excel can be imported directly to AutoCAD. 

This feature is an Auto-Update command.

Computer Aided Drafting

� Autodesk is the most popular drawing program

� Many student versions available for free online at students.autodesk.com

 AutoCAD

 Architecture

 Mechanical

 Revit

 Inventor

 Civil

      1.4.2. Microsoft office Project

Microsoft Project is a project management software program developed and sold by 

Microsoft, designed to assist a project manager in developing a schedule, assigning resources 

to tasks, tracking progress, managing the budget, and analyzing workloads.

Project creates budgets based on assignment work and resource rates. As resources are 

assigned to tasks and assignment work estimated, the program calculates the cost, equal to the 

work times the rate, which rolls up to the task level and then to any summary task, and finally 

to the project level.

Each resource can have its own calendar, which defines what days and shifts a resource is 

available. Microsoft Project is not suitable for solving problems of available materials 

(resources) constrained production. Additional software is necessary to manage a complex 

facility that produces physical goods.

A basic understanding of Computers and Windows Operating System is all it takes to get 

started. Hardware: A reasonable home desktop configuration. Software: MS Project 2013 on 

Windows OS. (At the time of writing this tutorial, Project 2013 is not available for Mac)

1.5. Computer instruction

      1.5.1CAD
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Starting a New Drawing

�The big A is like the home button in MS Office or the File menu in most programs

�The default template is good

Fig.1.17.new drawing
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Fig.18.temlate

       1.5.2 MS project

 Windows 7: Click on Start menu, point to All Programs, click Microsoft Office, and 

then click Project 2013.

 Windows 8: On the Start screen, tap or click Project 2013.

 Windows 10: Click on Start menu -> All apps -> Microsoft Office -> Project 2013.

The following screen is the Project’s start screen. Here you have options to open a new plan, 

some other plans, and even a new plan template.



Version -1Page 27 of 61 Ministry of Labor and 
Skills

Author/Copyright

Operating application soft ware 

august, 2022

Fig.1.19.ms office project

      

Self-check-1

Test-I Matching
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Instruction: select the correct answer for the give choice. You have given 1 Minute for each 

question. Each question carries 2 Point.

A B

---------1. AutoCAD A. To produce paper

---------2. Printer B. Type writer

---------3. Moues C. Many line

---------4. Monitor D. Computer screen

---------5. Key board E. Control the movement pointer

F. to create design and models

Test II: short Answer writing

Instruction: write short answer for the given question. You are provided 3 minute for each 

question and each point has 5Points.

1. What is Occupational Health?

2. Write down at least three equipment used for CAD and MS Project?

3. What is the difference between CAD and MS project soft wear?

Part III: Short answer writing

Direction:  Give short answer to the following questions. Time allotted for each item is 

2mniut and each question carry 4 point.

1. Desktop

2. MS project

Note: Satisfactory rating – above 60%           Unsatisfactory - below 60%

You can ask you teacher for the copy of the correct answers

 Operation title: installing CAD soft wear

 Purpose: To know how installing CAD soft wear

 Instruction: Using the auto cad 2007 install to new computer.

Operation sheet 1.1: CAD and micro soft office project environment 
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 Tools and requirement:

1. Computer full accessory

2. CAD soft wear

Procedures 

Step 1: Access the Autodesk website

Use web browsers like Google Chrome, Mozilla Firefox, etc. Then Go to the AutoCAD 

official website by using this link: https://www.autodesk.com

Step 2: Select Students and Educators from Drop down list of the Menu.

It will give you three options, i.e. free trials, students and educators, and worldwide sites. 

Here I am selecting the students and educators option.

Step 3: Then, you will see Get set up for career success with the Autodesk tab. From that tab, 

click on Start now under Download free software option.

Step 4: It will give a list of Autodesk products like 3DS Max, Maya, AutoCAD, etc. Under 

that, click on the AutoCAD option from the list.

Step 5: If you have already registered, then click on Sign in, and you will be forwarded to 

your Autodesk Login information. Otherwise, click on Create Account and create a new 

account using your email ID.

Step 6: Select version After signing in, you can select the version of AutoCAD you want to 

download and install and Operating System: 32 bit or 64 bit.

Step 7: License and Services Agreement After that, you will see the “License and Services 

Agreement” Prompt. Read it carefully, and then click on the “I Accept” option, then click the 

next button to install AutoCAD on your Windows System

Step 8: After the installation of the manager, you will see an “Autodesk Download Manager” 

window. Specify the desired path where you want to save that file and click on OK.

The Autodesk Download manager will be loading.

Step 9: After that, you will see a window where you can configure the Autocad installation 

process. Here give the path where you want to save the files

https://www.autodesk.com/
https://www.educba.com/windows-operators/
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Step 10: In the next window, select the Custom Option. Make sure all the features under the 

drop-down are checked.

Step 13: After finishing the installation, you have to provide a Product Key to further the use 

of AutoCAD.

Lap Test-1

LAP Test-1 Practical Demonstration

Name: __________________________                                Date: ____________

Time started: ____________________           Time finished: _______________

Instruction I: Given necessary templates, tools and materials you are required to perform the 

following tasks within 3 hours.
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Task 1:  install MS project software
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Unit Two:  Open software application and manipulate desktop

This unit to provide you the necessary information regarding the following content coverage 

and topics:

 software icons 

 Open, close and access software features for CAD and MS project 

 Basic function tool for CAD and MS project software.

This guide will also assist you to attain the learning outcomes stated below. Upon completion of 

this learning guide, you will be able to:

 Perform application software icons. 

 Perform open, close and access software features for CAD and MS project.

 Identify basic function to CAD and MS project software.
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2.1. Software icons 

          2.1.1. CAD 

Long ago when people were building pyramids, they required a lot of measuring skills. It is 

interesting to look at how people developed a system of measures. They started by comparing 

two quantities, which led to phrases such as ‘taller than’, ‘longer than’, ‘heavier than’, ‘holds 

more than’, etc. People still do this by themselves when they are working on the land.

Measurement is how we determine the exact capacity of something that is in solid, liquid or 

gas form. 

          2.1.2. CAD icons

Fig.2.1.Tool

     

Architecture of AutoCAD

https://www.educba.com/design/courses/autocad-training-course/?btnz=edu-blg-inline-banner3
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Here are some special features added which are related to architecture as stated below:

Fig.2.2.drawing window

           2.1.3. MS project

https://www.educba.com/design/courses/autocad-training-course/?btnz=edu-blg-inline-banner3
https://www.educba.com/design/courses/autocad-training-course/?btnz=edu-blg-inline-banner3
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Fig.2.3.tool bar

           

2.2. Open, close and access features for CAD and MS project.

     2.2.1 Start a Program

To start a program, do the following;

1. Click on the Start Button.

2. Click on the All Programs, you will see a list of all the program icons and program 

folders.

3. Point to the desired folder say Accessories and select the desired program to run such as 

Paint.

          2.2.2. Opening AutoCAD 2007

AutoCAD 2007 is designed to work in a Windows operating system. In general, to open 

AutoCAD 2007, either double-click on the AutoCAD 2007 shortcut in the Windows desktop 

or right-click on the icon, followed by a left-click on Open in the menu which then appears
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Fig.2.4.auto cad icon

2.2.3. Opening of MS project

Windows 7: Click on Start menu, point to All Programs, click Microsoft Office, and

then click Project 2013.

 Windows 8: On the Start screen, tap or click Project 2013.

 Windows 10: Click on Start menu -> All apps -> Microsoft Office -> Project 

2013.

The following screen is the Project’s start screen. Here you have options to open 

a new plan, some other plans, and even a new plan template.
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Fig.2.5.ms project temple

.

2.3. Function tools for CAD and MS project software.

2.3.1. CAD tool

. Various AutoCAD Tools

Here are the various AutoCAD Tools which are given below

1. Line

You can invoke the LINE command by choosing the LINE tool from the Draw panel, or you 

can also invoke the LINE tool by entering LINE or L at the Command Prompt. You will have 

to specify the starting point of the line by clicking the mouse then you will be prompted to 

specify the second point. You can terminate the LINE command by pressing ENTER, ESC or 

SPACEBAR.

2. Circle

A circle is drawn by using the CIRCLE command. You can draw a circle by using six 

different tools, i.e., by specifying center and radius, by specifying center and diameter, by 

specifying two diametrical ends, by specifying three points on a circle, tangent to two objects, 

tangent to three objects.
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3. Rectangle

You can draw rectangles by specifying two opposite corners of the rectangle, specifying the 

area and the size of one of the sides, or specifying the rectangle’s dimensions.

4. Polyline

Polylines means many lines. To draw a polyline, you need to invoke the PLINE command. 

After invoking the PLINE command and specifying the start point, the following prompt is 

displayed: Specify start point: specify the starting point or enter its coordinate

5. Trim

When creating a design, you may need to remove the unwanted and extending edge. In such 

cases, you can use the Trim tool. On invoking the Trim tool, you will be prompted to select 

the cutting edges. These edges can be lines, polylines, circles, arcs, ellipses, rays, splines, 

text, blocks, x lines or even viewports. After the cutting edge/edges are selected, you must 

select each object to be trimmed.

6. Extend

The Extend tool may be considered as the opposite of the Trim tool. You can extend lines, 

polylines, rays, and arcs to meet the other objects using the Extend tool. You can use this 

option whenever you want to extend the objects that do not actually intersect the boundary 

edge but would intersect its edge if the boundary edges were extended.

Fig.2.6.Extend 
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7. Copy

This tool is used to make the copies of the selected objects and place them at the specified 

location. On invoking this tool, you need to select the objects and then specify the base point. 

Next, you need to specify the second point where the copied objects have to be placed. You 

can continue specifying the second point for creating multiple copies of the selected entities.

8. Mirror

This tool is used to create a mirror copy of the selected objects. The objects can be mirrored 

at any angle. This tool is helpful in drawing symmetrical figures. On invoking this tool, you 

will be prompted to select objects. On selecting objects to be mirrored, you will be prompted 

to enter the first point of the mirror line and the second point of the mirror line. A mirror line 

is an imaginary line about which the objects are mirrored.

9. Rotate

On invoking this tool, you will be prompted to select the objects and the base point about 

which the selected objects will be rotated. By default, a positive angle results in 

counterclockwise rotation, whereas a negative angle results in a clockwise rotation. The 

Rotate tool can also be invoked from the shortcut menu by selecting an object and right-

clicking in the drawing area, and choosing Rotate from the shortcut menu.

10. Erase

Sometimes, you need to erase the unwanted objects from the objects drawn. To erase an 

object, choose Erase tool from the Modify panel. To invoke the Modify toolbar, choose 

View>Windows>Toolbars>AutoCAD>Modify from the ribbon. A small box, known as a 

pick box, replaces the screen cursor on invoking the Erase tool. To erase the object, select it 

by using the pick box; the selected object will be displayed in dashed lines, and the Select 

objects prompt will be displayed again. You can either continue selecting the objects or press 

ENTER to terminate the object selection process and erase the selected objects.

11. Offset

You can use the Offset tool to draw parallel lines, polylines, concentric circles, arcs, curves, 

etc., While offsetting an object, you need to specify the offset distance and the side to offset.

12. Move
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The Move Tool is used to move one or more objects from their current location to a new 

location without changing their size or orientation.

13. Array

You may need to create an object multiple times in a rectangular or circular arrangement in 

some cases. This type of arrangement can be obtained by creating an array of objects. In 

Rectangular Array, you need to mention the number of rows and columns along with the Row 

offset distance and Column offset distance. Whereas in Polar Array, you need to specify the 

Center point around which you need the number of objects.

14. Scale

Sometimes you need to change the size of objects in a drawing. For this purpose, the Scale 

tool comes in handy.

15. Fillet

The edges in a model are generally filleted to reduce the area of stress concentration. The 

fillet tool helps form round corners between any two entities that form a sharp vertex.

16. Explode

This tool is useful when you have inserted an entire drawing, and you need to alter a 

small detail. After you invoke the Explode tool, you are prompted to select the objects 

you want to explode. After selecting the objects, press ENTER or right-click to 

explode the selected objects and then end the command

2.3.2. MS project tool

The screen should have the MS Project interface displayed. The major part of this interface 

are: 

 Quick Access Toolbar: A customizable area where you can add the frequently used 

commands. 

 Tabs on the Ribbon, Groups: With the release of Microsoft Office 2007 came the 

"Fluent User Interface" or "Fluent UI", which replaced menus and customizable 

toolbars with a single "Office menu", a miniature toolbar known as "quick-access 

toolbar" and what came to be known as the ribbon having multiple tabs, each holding 

a toolbar bearing buttons and occasionally other controls. Toolbar controls have 
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heterogeneous sizes and are classified in visually distinguishable Groups. Groups are 

collections of related commands. Each tab is divided into multiple groups.

 Commands: The specific features you use to perform actions in Project. Each tab 

contains several commands. If you point at a command you will see a description in a 

tooltip.

 View Label: This appears along the left edge of the active view. Active view is the 

one you can see in the main window at a given point in time. Project includes lots of 

views like Gantt chart view, Network Diagram view, Task Usage view, etc. The View 

label just tells you about the view you are using currently. Project can display a single 

view or multiple views in separate panes.

 View Shortcuts: This lets you switch between frequently used views in Project.

 Zoom Slider: Simply zooms the active view in or out.

 Status bar: Displays details like the scheduling mode of new tasks (manual or 

automatic) and details of filter applied to the active view.

Self check-2

Test-I Matching

Instruction: select the correct answer for the give choice. You have given 1 Minute for each 

question. Each question carries 2 Point.

A B

---------1. Trim G. Remove unwanted edge

---------2. Extend H. Draw parallel line

---------3. Offset I. Create object multiple time

---------4. Array J. Reduce the area

---------5. Fillet K. Opposite of trim

L. Line

Test II: short Answer writing

Instruction: write short answer for the given question. You are provided 3 minute for each 

question and each point has 5Points.

4. What is the purpose of AutoCAD and MS project?
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5. Write the function of MS project?

Part III: Short answer writing

Direction:  Give short answer to the following questions. Time allotted for each item is 

2mniut and each question carry 4 point.

6. Copy

7. mirror 

8. erase 

9. scale

10. explode

11. command

Note: Satisfactory rating – above 60%           Unsatisfactory - below 60%

You can ask you teacher for the copy of the correct answers

 Operation title: drawing floor plan

 Purpose: using  bar tools draw floor plan

 Instruction:. You have given length-4m and width -3m width -20cm

 Tools and requirement:

1. Computer

2. AutoCAD software

Procedures in doing the task

1. Floor Plans

 Start a drawing using QNEW or choose the + tab.

 In-home Ribbon menu, launch the content browser.

 Select-create a cataloging tool, then browse it and choose the design.

 Then open it and click OK.

 Now the catalog is listed in a content browser.

Operation sheet 2.1 AutoCAD operation 

https://www.educba.com/design/courses/autocad-training-course/?btnz=edu-blg-inline-banner3
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 To add tools from the content palette.

 Launch the content browser, choose the design tool palette.

 In that, click on a new palette and rename it as walls.

 Now left-click on the Design tool catalog– Imperial on a content browser to open.

 In those categories, select walls.

 Then search for stud-4 and click on Go.

 Now select common wall type Stud-4 Rigid-1.5 Air-1 Brick-4. Then click on the left 

mouse button and adjust it to fit the screen.

 Now the designed wall is added to the wall tool palette.

 To have three wall style search CMU-8.

 Then locate CMU-8 Stud-4 Rigid-1.5 Air-1 Brick-4.

The floor, which is the main part of the architecture, is ready. Because with the help of floor 

measurements, only it can depict the room size, furniture, wiring system, etc.

https://www.educba.com/design/courses/autocad-training-course/?btnz=edu-blg-inline-banner3
https://www.educba.com/design/courses/autocad-training-course/?btnz=edu-blg-inline-banner3
https://www.educba.com/design/courses/autocad-training-course/?btnz=edu-blg-inline-banner3
https://www.educba.com/design/courses/autocad-training-course/?btnz=edu-blg-inline-banner3
https://www.educba.com/design/courses/autocad-training-course/?btnz=edu-blg-inline-banner3
https://www.educba.com/design/courses/autocad-training-course/?btnz=edu-blg-inline-banner3
https://www.educba.com/design/courses/autocad-training-course/?btnz=edu-blg-inline-banner3
https://www.educba.com/design/courses/autocad-training-course/?btnz=edu-blg-inline-banner3
https://www.educba.com/design/courses/autocad-training-course/?btnz=edu-blg-inline-banner3
https://www.educba.com/design/courses/autocad-training-course/?btnz=edu-blg-inline-banner3
https://www.educba.com/design/courses/autocad-training-course/?btnz=edu-blg-inline-banner3
https://www.educba.com/design/courses/autocad-training-course/?btnz=edu-blg-inline-banner3
https://www.educba.com/design/courses/autocad-training-course/?btnz=edu-blg-inline-banner3


Version -1Page 44 of 61 Ministry of Labor and 
Skills

Author/Copyright

Operating application soft ware 

august, 2022

LAP Test-2 Practical Demonstration

Name: __________________________                                Date: ____________

Time started: ____________________           Time finished: _______________

Instruction I: Given necessary templates, tools and materials you are required to perform the 

following tasks within 3 hours.

Task 1: draw floor plan
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Unit Three:  Print  

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics:

 Print from installed software. 

 view progress of print 

This guide will also assist you to attain the learning outcomes stated below. Upon completion of 

this learning guide, you will be able to:

 Perform print from installed software. 

 Perform view progress of print 
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3.1. Print from installed software. 

    3.1.1. Printing CAD Drawings from the Printer Driver

1. Open the file you want to print in your CAD software.

2. Click Plot and select your product as the printer

3. Click Properties.

4. On the Device and Document Settings tab, click Custom Properties. ...

5. Select the Document Size and Output Size settings as necessary

            3.1.2.Printing CAD Drawings from the Printer Driver

You can print CAD drawings using your printer driver. This printing method is best for high 

quality views and drawings.

Note: If lines in your drawing are not printed properly, print the drawing using HP-GL/2 or 

HP RTL mode using the product control panel.

1. Open the file you want to print in your CAD software.

2. Click Plot and select your product as the printer.

3. Click Properties.

4. On the Device and Document Settings tab, click Custom Properties. You 

see the printer driver window:
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Fig.3.1.printer properties

5. Select the Document Size and Output Size settings as necessary. 

6. Select the Source setting.

7. Select the Media Type setting.

8. Choose one of the CAD/Line Drawing options as the Select Target setting. 

Select any other printing settings as necessary and click OK.

9. Start printing your drawing from the CAD software

3.2. View progress of Print
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�You can apply a page setup to your layout to make the printing process quicker every time

Fig.3.2.page setup manager
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Fig.3.3.print lay out

Self check-3

Test-I Matching
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Instruction: select the correct answer for the give choice. You have given 1 Minute for each 

question. Each question carries 2 Point.

A B

---------1. A4 size M. Showing print document size

---------2. printer N. Selecting printer and size

---------3. Plot O. 8,27”*11.69”

---------4. Print view P. 8”*12”

Q. A device used for print

Test II: short Answer writing

Instruction: write short answer for the given question. You are provided 3 minute for each 

question and each point has 5Points.

12. What is the functions of print?

13. Write the step of printing document?

Part III: Short answer writing

Direction:  Give short answer to the following questions. Time allotted for each item is 

2mniut and each question carry 4 point.

14. print

15. plotter 

16. print view 

Note: Satisfactory rating – above 60%           Unsatisfactory - below 60%

You can ask you teacher for the copy of the correct answers

 Operation title: printing of AutoCAD drawings

 Purpose: select the correct paper size and printer

Operation sheet 3.1 printing.
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 Instruction:. You have given AutoCAD drawing in computer document

 Tools and requirement:

3. Computer

4. AutoCAD software

Procedures in doing the task

1. Either select Plot . . . with a click on its tool icon in the Standard New toolbar or from 

the File drop-down menu. The Plot dialog appears 

2. There are two parts in the Plot dialog. Fig. A.6 shows both the parts. A click on the 

arrow at the bottom right-hand corner of the dialog closes to reveal only the left-hand 

part and vice versa.

3. Select an appropriate printer or plotter from the Printer/Plotter list. Then select the 

correct paper size from the Paper size popup list. Then select what is to be 

printed/plotted from the what to plot popup list – in the example shown this is 

Display. Make sure the Landscape button is showing a dot (on). Then click the 

Preview button.

4. A preview of the drawing to be printed/plotted appears (Fig. A.7). If satisfied with the 

preview, right-click and in the menu which appears click Plot. If not satisfied click 

Exit. The preview disappears and the Plot dialog reappears. Make changes as required 

from an inspection of the preview and carry on in this manner until a plot can be 

made. 
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LAP Test-3 Practical Demonstration

Name: __________________________                                Date: ____________

Time started: ____________________           Time finished: _______________

Instruction I: Given necessary templates, tools and materials you are required to perform the 

following tasks within 1 hours.

Task 1: print drawing 
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Unit Four:   Shut down

This unit is developed to provide you the necessary information regarding the following content 

coverage and topics:

  close on open application

 Shut down computer. 

.

This unit will also assist you to attain the learning outcomes stated below. Upon completion of 

this learning guide, you will be able to:

 Perform close on open application 

 Apply shut down computer. 
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4.1. Close on open application 

Quit a Program

To quit a program, select the close button (×) in the upper right

corner of the window OR

Click on File menu and select Close option

To Close All Project Files

 Click Close All Project Drawings. ...

 On the Project Navigator palette, right-click below the file tree, and click Close All 

Project Files. ...

 On the Project tab of the Project Navigator palette, click, then specify your 

preferences in the Project Browser - Close Project Files dialog box.

4.2. Shut down

Step of shut down

1. Press start button

2. Press power

3. Press shut down

Self-check-4

Test-I Matching
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Instruction: select the correct answer for the give choice. You have given 1 Minute for each 

question. Each question carries 2 Point.

A B

---------1close R. Using “X” singe

---------2. Shut down S. Total computer close

 T. Document or application

Test II: short Answer writing

Instruction: write short answer for the given question. You are provided 3 minute for each 

question and each point has 5Points.

17. What is the functions of close out?

18. Write the step of shout down?

Part III: Short answer writing

Direction:  Give short answer to the following questions. Time allotted for each item is 

2mniut and each question carry 4 point.

19. Shout down

20. close

Note: Satisfactory rating – above 60%           Unsatisfactory - below 60%

You can ask you teacher for the copy of the correct answers

Shut down

 Operation title: Closing on open application 

 Purpose: close application

 Instruction:. You have given document and application clos out

Operation sheet 4.1 
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 Tools and requirement:

5. Computer

6. Open application

Procedures in doing the task

To quit a program, select the close button (×) in the upper right

corner of the window OR

Click on File menu and select Close option

LAP Test-4 Practical Demonstration

Name: __________________________                                Date: ____________

Time started: ____________________           Time finished: _______________

Instruction I: Given necessary templates, tools and materials you are required to perform the 

following tasks within 1 hours.

Task 1: close application 
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